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Eros adalah pengikisan material yang merupakan proses penghanyutan
tanah oleh desakan-desakan atau kekuatan air dan angin baik yang berlangsung
secara alamiah maupun sebagai akibat tindakan manusia. Kegiatan pembukaan
lahan dapat mengakibatkan pengaruh buruk terhadap tanah dan vegetasi penutup
diatasnya sehingga terjadi degradasi lahan. Terjadinya erosi akan berakibat lahan
kritis yang semakin luas dan memberikan dampak yang negatif bagi daerah
sekitarnya. Untuk menangani masalah tersebut, perlu ada tindakan dan upaya
konservasi tanah dan air dengan memprediksi tingkat bahaya erosi.

Dengan menghitung laju erosi dapat diketahui tingkat bahaya eros suatu
daerah. Universal Soil Loss Equalition (USLE) merupakan metode yang
digunakan untuk memprediks lgu erosi. USLE merupakan metode yang
dirancang untuk memprediks lgju rata-rata eros jangka panjang pada suatu
bidang tanah tertentu. Beberapa parameter input USLE meliputi erosivitas hujan
(R), erodibilitas tanah (K), panjang dan kemiringan lereng (LS), indeks
pengelolaan tanaman (C), dan tindakan konseravas tanah (P). Penelitian ini
bertujuan @) memprediksi besarnya lgju erosi, b) mengklasifikasi tingkat bahaya
erosi, dan ¢) menentukan luas tingkat bahaya erosi terbesar dan terkecil.

Penelitian ini dilaksanakan di wilayah administratif UPT PSDA Kediri
Provinsi Jawa Timur. Luas wilayah sebesar 399.963,1 hapada proyeksi peta UTM
49 Southern Hemisphere 1984 dengan datum global WGS 84. Input data meliputi
data curah hujan tahunan (2004 — 2008) untuk menghitung faktor R, data DEM
dengan resolusi 30x30 m dari ASTER G-DEM untuk menghitung faktor LS peta
sebaran stasiun hujan, peta jenis tanah, dan peta tataguna lahan. Data tersebut
diperoleh dari Laboratorium Teknik Pengendalian dan Konservasi Lingkungan,
Jurusan Teknik Pertanian, Fakultas Teknologi Pertanian, Universitas Jember. Data
nilai faktor K dan CP mengacu pada data DAS Brantas. ArcGIS 10.0 merupakan
software GIS yang digunakan untuk mengolah data analisis erosi.

Secara keseluruhan total laju erosi wilayah administratif UPT PSDA
Kediri yaitu 15,79 ton/ha/tahun atau 1,32 mm/tahun. Dengan demikian, lgju eros
masih di bawah batas normal dari erosi yang ditoleransi. Tingkat bahaya erosi
diklasifikasi kan menjadi 5 kelas yaitu sangat ringan (1,68 ton/ha/tahun), ringan
(32,46 ton/haltahun), sedang (101,72 ton/ha/tahun), berat (282,33 ton/haltahun),
dan sangat berat (1.297,58 ton/hal/tahun) pada UPT PSDA Kediri. Tingkat bahaya
eros kelas ringan UPT PSDA Kediri seluas 319.043,61 ha atau 80,54% bagian,
dan tingkat bahaya erosi kelas sangat berat seluas 870,32 ha atau 0,22% dari
wilayah keseluruhan.

vii


http://repository.unej.ac.id/
http://repository.unej.ac.id/

SUMMARY

The Prediction on Erosion Rate Using Universal Soil Loss Equation (USLE)
and ArcGIS in Administrative Area of UPT PSDA Kediri; Rachmat Agung
Aryanata, 111710201039; 2016: 44 pages, Departement of Agricultural
Engineering, Faculty of Agricultural Technology, Jember University

Erosion is the detachment of material which is aresult of transportation by
water and wind forces. Either naturally or as a result of human actions.
Deforestation may give negative effects to the soil and vegetation cover on it, then
causing land degradation. Erosion will affect to the degraded land become wider
and give a negative effect to the surrounding area. To solve that problems, needs a
effort and soil and water conservation by predicting of erosion rate.

By predicting the erosion rate, the erosion rate can be known in the area.
Universal Soil Loss Equalition (USLE) is a method to predict the erosion rate.
USLE method was designed to predict the average erosion rate on a long-term of
certain land. Some input parameters for USLE include rainfall erosivity (R), soil
erodibility (K), the length and slope (LS), the index of crop management (C), and
the land conservation action (P). Aims this study a) were to predict the erosion
rate, b) classifying the erosion rate, and c) determine the largest and smallest area
of erosion rate.

This research was conducted in the administrative area UPT PSDA Kediri
in East Java province. An area was about 399,963.1 ha on map projection UTM
49 Southern Hemisphere global WGS 1984 datum 84. Data input includes the
annual rainfall data (2004-2008) to calculate the R factor, DEM data with a
resolution of 30x30 m of ASTER G-DEM to calculate LS factor, distribution of
rainfall station map, soil types and land use maps. The data obtained from the
Laboratory of Enviromental Control and Conservation, Agricultural Engineering
Department, Faculty of Agricultural Technology, University of Jember. K factor
value data and CP, refers to the Brantas watershed data. ArcGIS 10.0 is a GIS
software that using to process the data analysis of erosion.

Overall, the total erosion rate of UPT PSDA administrative area in Kediri
was 15.79 tonnes / ha/ year or 1.32 mm / year. Thus, the erosion rate still below
the normal limit of the tolerable erosion. The erosion rate can be classified into
five classes: very low (1.68 tonnes / ha/ year), low (32.46 tonnes / ha / year),
moderate (101.72 ton / ha/ year), high (282, 33 tonnes/ ha/ year), and very high
(1297.58 tonnes / ha / year) on UPT PSDA, Kediri. The low erosion of UPT
PSDA Kediri area was 319,043.61 ha or 80.54%, and the erosion rate on severe
level area of 870.32 ha, or 0.22% of the overall area.
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BAB 1. PENDAHULUAN

1.1 Latar Belakang

Eros merupakan fenomena alam yang sering terjadi di muka bumi. Erosi
adalah pengikisan atau kelongsoran material yang sesungguhnya merupakan
proses penghanyutan tanah oleh desakan-desakan atau kekuatan air dan angin baik
yang berlangsung secara alamiah maupun sebagal akibat tindakan atau perbuatan
manusia (K artasapoetra dan Sutedjo, 1987:46). Besarnya erosi dipengaruhi faktor-
faktor tertentu seperti pemanfaatan lahan yang tidak sesuai, penggundulan hutan,
perluasan lahan pertanian, dan pembukaan lahan pemukiman baru. Kegiatan
pembukaan lahan dapat mengakibatkan pengaruh buruk terhadap tanah dan
vegetas penutup diatasnya sehingga terjadi degradasi lahan. Terjadinya erosi
tanah akan berakibat luas dan kualitas lahan kritis yang semakin luas dan
memberikan dampak yang negatif bagi daerah sekitarnya. Dapat dikatakan
manusia sangat berpengaruh dalam fenomena ini. Selan manusia eros
dipengaruhi oleh faktor lain yaitu iklim, erodibilitas tanah, dan topografi.

Erosi merupakan proses pengikisan lapisan tanah top soil yang berjalan
lambat. Kikisan tanah akibat curah hujan yang tinggi menyebabkan tanah
mengalami perpindahan tempat dan terbawa oleh airan air sehingga terjadi
endapan pada sungai, saluran irigasi, waduk, muara sungai, dan badan air lainnya.
Endapan tersebut dapat menyebabkan pendangkalan dan atau penyempitan pada
sungai yang akan berpengaruh pada kapasitas tampung pada saluran tersebut.
Apabila debit air besar sedangkan kapasitas sungai kecil maka ha ini dapat
menimbulkan bencana yang serius.

Lahan kritis adalah lahan di dalam maupun di luar kawasan hutan yang
telah mengalami kerusakan, sehingga kehilangan atau berkurang fungsinya
sampa pada batas yang ditentukan atau diharapkan (Kemenhut, 2009). Lahan
kritis merupakan lahan yang tidak memiliki vegetas penutup dan lahan yang
hilang kesuburannya. Hal tersebut dapat berpotens terjadinya erosi. Pada daerah
UPT PSDA Kediri tepatnya di Kabupaten Nganjuk, lahan kritis pada tahun 2008
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sebesar 9170,11 Ha sedangkan pada tahun sebelumnya hanya 550,00 Ha
(Bappenas, 2012).

Untuk menangani masalah tersebut perlu ada tindakan dan upaya
konservasi tanah dan air dengan memprediksi tingkat bahaya erosi. Dengan
menghitung laju erosi dapat diketahui tingkat bahaya erosi suatu daerah. Lahan
kritis disebabkan salah satunya oleh erosi lembar dan erosi alur. Universal Soil
Loss Equalition (USLE) merupakan metode yang digunakan untuk memprediksi
lgju erosi lembar dan erosi aur. Selain itu dirancang untuk memprediksi 1gju rata-
rata erosi jangka panjang pada suatu bidang tanah tertentu. Metode ini dapat
digunakan untuk tanah tempat bangunan dan penggunaan non pertanian, tetapi
tidak dapat memprediks pengendapan dan memperhitungkan hasil sedimen
(Arsyad, 2012:76).

1.2 Rumusan Masalah

Lahan kritis terjadi ketika tataguna lahan di daerah tersebut tidak
diperhatikan. Hal tersebut ditunjukkan bahwa tataguna lahan UPT PSDA Kediri
kurang diperhatikan sehingga terjadi peningkatan luas lahan kritis yang besar.
Oleh sebab itu perlu dilakukan prediks besar lgu eros yang terjadi sebagai

pertimbangan tindakan konservasi.

1.3 Batasan Masalah

Prediks lgju erosi dilakukan dengan menggunakan integrasi ArcGIS dan
pemodelan metode USLE dengan masukan data curah hujan, peta jenis tanah,
tataguna lahan serta data DEM.

1.4  Tujuan Pendlitian
1. Memprediks besarnyalagju erosi;
2. Mengklasifikasi tingkat bahaya erosi;

3. Menentukan luas tingkat bahaya erosi terbesar dan terkecil.
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15 Manfaat Pendlitian

1. Memberikan informasi tentang besar eros yang klasifikasi tingkat bahaya
erosi;

2. Dapat mengetahui luas tingkat bahaya erosi terbesar dan terkecil;

3. Sebagai bahan pertimbangan bagi pihak-pihak terkait guna perencanaan

penggunaan lahan dan konservasi tanah.
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BAB 2. TINJAUAN PUSTAKA

2.1 Daerah Aliran Sungai (DAS)

DAS adadah suatu wilayah daratan yang secara topografi dibatasi oleh
punggung-punggung gunung yang menampung air hujan kemudian mengalirkan
ke laut melalui sungai utama (Asdak, 2002). Berdasarkan PP nomor 37 tahun
2012 pasal 1 menyatakan bahwa DAS adalah suatu wilayah daratan yang
merupakan satu kesatuan dengan sungai dan anak-anak sungainya yang berfungsi
menampung, menyimpan, dan mengalirkan air yang berasal dai curah hujan ke
danau atau ke laut secara alami yang batas di darat merupakan pemisah topografis
dan batas di laut sampai dengan daerah perairan yang masih terpengaruh aktivitas
daratan.

Air pada DAS merupakan aliran air yang mengalami siklus hidrologi
secara alamiah. Perjalanan air dari permukaan laut ke atmosfer kemudian ke
permukaan tanah dan kembali lagi ke laut yang tidak pernah berhenti, air tersebut
akan tertahan (sementara) di sungai, danau atau waduk, dan dalam tanah sehingga
akan dimanfaatkan oleh manusia atau makhluk hidup.

DAS dibagi menjadi tiga wilayah yaitu wilayah hulu, wilayah tengah, dan
wilayah hilir. Ketiga wilayah tersebut memiliki karakteristik dan fungs yang
berbeda, yaitu (Kemenhut, 2013: 13):

1. DAS bagian hulu didefinisikan sebagai daerah airan yang terbatas pada
bagian hulu dimana >70% dari permukaan lahan DAS tersebut umumnya
mempunyai kemiringan lahan >8%. Disini, Aspek prioritas pemanfaatan
lahan adalah konsevasi tanah dan pengendalian erosi. Secara hidrologis, DAS
bagian hulu biasanya membentuk daerah utama pengisian kembali curah
hujan untuk air permukaan dan air tanah dari DAS.

2. DAS bagian tengah didefinisikan sebagai aliran yang terbatas pada bagian
tengah, dimana kurang lebih 50% dari permukaan lahan DAS tersebut
mempunyai  kemiringan lahan <8% serta dimana baik konservasi tanah
maupun pengendalian banjir adalah sama pentingnya. Secara hidrologis DAS

bagian tengah membentuk daerah utamatransisi curah hujan untuk air tanah.
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3. DAS bagian hilir didefinisikan sebagal daerah aliran yang terbatas pada
bagian hilir, dimana kurang lebih 70% permukaan lahanya mempunyai
kemiringan 8%. Disini, pengendalian banjir dan drainage biasanya
merupakan faktor-faktor yang terabaikan dalam pengembangan tata guna
lahan.

2.2  Bentuk-Bentuk DAS
Menurut Effendi (2008) sebagai aliran sungai, DAS tentu memiliki pola
tersendiri. Polaini kemudian dibagi ke dalam beberapa bentuk, antaralain:
1. Bentuk Bulu Ayam
Pola airan yang satu ini memiliki bentuk seperti bulu ayam dengan debit
banjir sekuensial dan berurut. Pola ini memakan waktu yang lebih singkat untuk
mencapai titik mainstream. Adapun topografinya cenderung curam dibandingkan

dengan bentuk DAS lainnya.

Gambar 2.1 DAS Bentuk Bulu Ayam
(Sumber: Effendi, 2008)

2. Bentuk Kipas

Bentuk DAS yang satu ini memiliki kesamaan dengan kipas dimana debit
banjirnya terakumulasi dari banyak arah sungai. Bentuk DAS yang satu ini
memiliki waktu yang jauh lebih lama dari pada bentuk bulu ayam dalam mencapai
titik mainstream. Bentuk kipas memiliki topografi yang relatif landai daripada

bulu ayam.
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Gambar 2.2 DAS Bentuk Kipas
(Sumber: Effendi, 2008)

3. Bentuk Parael atau Kombinasi

Pola DAS yang satu ini merupakan bentuk kombinasi dimana ia memiliki
debit banjir yang juga diakumulasikan dari berbagai arah sungai di titik hilir.
Sedangkan bagian hulunya bersifat sekuensial dan berurut.

Gambar 2.3 DAS Bentuk Parael/K ombinasi
(Sumber: Effendi, 2008)

Terjadinya erosi tanah akan berakibat luas dan kualitas lahan kritis yang
semakin luas dan memberikan dampak yang negatif bagi daerah sekitarnya.
Beberapa masalah DAS di Indonesia antaranya adalah banjir, produktivitas tanah
menurun, pengendapan lumpur pada waduk, saluran irigasi, proyek tenaga air, dan
penggunaan tanah yang tidak tepat (Effendi, 2008).
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23 FEros

Menurut Kartasapoetra dan Sutedjo (1987:46), erosi juga disebut sebagai
pengikisan atau kelongsoran tanah merupakan proses penghanyutan tanah oleh
desakan-desakan atau kekuatan air dan angin balk yang berlangsung secara
alamiah maupun sebagai akibat atau tindakan dari manusia. Eros memiliki
dampak yang sangat luas. Kerusakan dan kerugian tidak saja di alami daerah yang
mengalami erosi, namun daerah yang dialiri endapan dan ujung daerah aliran atau
bagian hilir. Tetapi kerugian yang disebabkan oleh eros berbeda untuk tiap
daerah hulu, daerah tengah, dan daerah hilir (Rahim, 2000:7).

Menurut Utomo (1989:21) proses erosi bermula dengan terjadinya
penghancuran agregar-agregat tanah sebagai akibat pukulan air hujan yang
mempunyai energi lebih besar dari daya tahan tanah. Sedangkan hancurnya dari
tanah ini akan menyumbat pori-pori tanah, maka kapasitas infiltrasi tanah akan
menurun dan mengakibatkan air mengalir di permukaan tanah dan disebut sebagai
limpasan permukaan. Limpasan permukaan mempunyai energi untuk mengikis
dan mengangkut partikel-partikel tanah yang telah dihancurkan.

Faktor penyebab terjadinya erosi antara lain: (1) iklim; (2) topografi; (3)
vegetasi; (4) tanah, dan; (5) manusia. Faktor iklim merupakan faktor yang
berkaitan dengan hujan. Besar hujan, intensitas, dan distribusi hujan menentukan
kekuatan dispersi hujan terhadap tanah, jumlah kecepatan aliran permukaan, dan
kerusakan erosi. Faktor topografi akan berpengaruh memperbesar Igu aliran
permukaan, semakin curam atau miring lereng akan memperbesar energi angkut
air terhadap partikel-partikel tanah yang telah terkikis (Arsyad, 2012:72).

Eros dapat digolongkan menjadi dua yaitu erosi norma dan dipercepat.
Eros norma atau erosi dam merupakan suatu keadaan yang diperbolehkan
karena jumlah tanah yang tererosi lebih kecil daripada terbentuknya tanah baru.
Sedangakan eros yang dipercepat merupakan pengangkutan tanah yang
menimbulkan kerusakan tanah sebagal akibat perbuatan manusia yang
mengganggu keseimbangan antara proses pembentukan dan pengangkutan tanah
(Arsyad, 2012:30).
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Unsur-unsur bentuk wilayah yang penting dalam mempengaruhi tingkat
eros adalah dergat kemiringan dan panjang lereng. Dengan instensitas hujan
yang tinggi akan meningkatkan erosi dengan bertambahnya panjang suatu lereng.
Erosi akan menurun jika intensitas hujan yang rendah. Namun kemiringan lereng
jugamenjadi ukuran besarnya erosi di lereng tersebut. Semakin curam kemiringan
lereng maka erosi semakin meningkat dan sebaliknya (Arsyad, 2012:52).

24  Bentuk Erosi

Menurut Arsyad (2012:31) terdapat lima bentuk erosi antaralain:
1. Erosi Lembar (sheet erosion)

Pengangkutan lapisan tanah yang merata tebalnya dari suatu permukaan
bidang tanah. Kekuatan jatuh butir-butir hujan dan airan air di permukaan tanah
merupakan penyebab utama erosi ini.

2. Erosi Alur (riil erosion)

Eros aur terjadi karena air terkonsentrasi dan mengalir pada tempat-
tempat tertentu di permukaan tanah sehingga pemindahan tanah lebih baanyak
terjadi. Eros ini biasa terjadi pada tanah yang ditanami dengan tanaman yang
ditanam berbaris menurut lereng.

3. Erosi Parit (qullu erosion)

Proses terjadinya erosi parit sama dengan eros aur, tetapi saluran-saluran
yang terbentuk sudah terlalu dalam sehingga perlu pengolahan tanah yang serius.
Daerah yang mengalami erosi parit sulit untuk untuk dijadikan lahan pertanian.

4. Eros Tebing Sungai (stream bank erosion)

Terjadi akibat pengikisan air yang mengalir dari bagian atas tebing atau
oleh terjangan arus air yang kuat pada saluran atau selokan sungai. Erosi tebing
sungai akan lebih hebat terjadi jikavegetasi penutup tebing telah habis.

5. Longsor (landslide)

Eros yang pengangkutan atau pemindahan tanahnya terjadi dalam volume

yang besar. Longsor terjadi akibat meluncurnya suatu volume tanah di atas suatu

lapisan agak kedap air yang jenuh air.
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25 Prediks Eros Menggunakan USLE

Perkiraan besarnya eros terkait oleh faktor-faktor topografi, vegetasi dan
meteorologi. Persamaan perhitungan erosi tersebut dikembangkan lagi agar
memperoleh suatu metode yang bersifat umum. USLE dikembangkan pertama
kali di United Sate Department of Agriculture-Soil Conversation Services
(USDA-SCS) bekerjasama dengan Universitas Purdue oleh Wischmeier dan
Smith (1978). Metode ini memiliki persamaan yang sederhana dan bersifat umum
untuk suatu lahan, baik lahan pertanian maupun non-pertanian atau campuran.
USLE bak untuk digunakan pada perhitungan erosi dalam jangka waktu yang
lama. USLE merupakan pemodelan yang memungkinkan perencanaan laju rata-
rata eros suatu tanah tertentu pada suatu kecuraman lereng dengan pola hujan
tertentu untuk setigp macam pertanaman dan tindakan konservasi tanah yang
mungkin dilakukan atau sedang dipergunakan. Bentuk erosi yang dapat diprediksi
adalah erosi aur dan eros lembar, terapi metode ini tidak dapat memprediksi
pengendapan dan tidak dapat menghitung hasil sedimen dari erosi parit, tebing
sungai, dan dasar sungai (Arsyad, 2012:248).

Metode USLE sendiri dalam aplikasinya memiliki enam variable.
Kombinasi enam variabel tesebut menurut persamaan Wischmeier dan Smith
(1978:4) adalah sebagai berikut :

S B B R (2.1
Keterangan: A : banyaknyatanah tererosi per satuan luas per satuan waktu
(ton/tahun)

R : faktor erosivitas hujan dan aliran permukaan (MJ.mm/tahun)
: faktor erodibilitas tanah (ton/MJ.mm)
: faktor panjang lereng
. faktor kemiringan lereng
. faktor tanaman penutup lahan

T 0O n - X

: faktor tindakan konservasi
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25.1 Faktor Erosivitas Hujan (R)

Erosivitas adalah kemampuan hujan merusak tanah atau menyebabkan
tanah tererosi. Di Indonesia Bols menentukan persamaan untuk menghitung nilai
R berdasarkan pada studi empiris dari rata-rata tahunan curah hujan (P) dalam
satuan mm (Teh et al., 2011). Besarnya erosivitas hujan dapat dihitung

mengeunakan persamaan berikut

2,5p2

R = W ........................................................................................ (2.2)
Keterangan: R = indeks erosivitas rata-rata per tahun (MJ.mm/tahun)
P = curah hujan rata-rata tahunan (mm/tahun)

2.5.2 Faktor Erodibilitas (K)

Faktor erodibilitas tanah (K) menunjukkan resistensi partikel tanah
terhadap pengelupasan dan transportasi partikel-partikel tanah oleh adanya energi
Kinetik air hujan, meskipun besarnya resistensi tersebut di atas akan tergantung
pada topografi, kemiringan lereng, dan besarnya gangguan oleh manusia
Besarnya erodibilitas atau resistens tanah juga ditentukan oleh karakteristik tanah
seperti tekstur tanah, stabilitas agregat tanah, kapasitas infiltrasi, kandungan
organik dan kimia tanah. Tanah yang mempunyai erodibilitas tinggi akan tererosi
lebih cepat dibandingkan dengan tanah yang mempunyai erodibilitas rendah,
dengan intensitas hujan yang sama. Jadi sifat-sifat fisik, kimia dan biologi tanah
juga mempengaruhi besarnya erodibilitas. Klasifikas Nilai K menurut Arsyad
dapat dilihat pada Tabel 2.1.

Tabel 2.1 Nilai K Berdasarkan Jenis Tanah di DAS Brantas

Jenis Tanah Nilai K Tingkat Erodibiltas
Aluvial 0,29 Sedang
Andosol 0,28 Sedang
Brown Forest 0,28 Sedang
Glei 0,29 Sedang
Grumosol 0,16 Rendah
Latosol 0,26 Sedang
Litosol 0,13 Rendah
Mediteran 0,16 Rendah

Organosol 0,29 Sedang
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Podsol Merah 0,20 Rendah
Regosol 0,31 Agak tinggi

(Sumber:Arsyad, 2012:143)

2.5.3 Faktor Panjang Kemiringan Lereng (LS)

Panjang lereng dihitung mulai dari tempat terjadinya airan air sampai ke
tempat mulai terjadinya pengendapan yang disebabkan oleh berkurangnya
kemiringan lereng atau ke tempat aliran air di permukaan tanah masuk ke dalam
sduran (Arsyad, 2012 : 81-82). Nilai LS dapat dicari dengan memanfaatkan data
DEM pada SIG dengan persamaan berikut

. 1.3
LS = (Xx €Z/22,13)%*x (=)

Keterangan: LS  :faktor lereng
X : akumulasi aliran (flow accumulation)
CZ  :ukuran pixel
0 : kemiringan lereng (slope) (°)
Menurut Rahim (2000: 73) klasifikas kemiringan lereng dibagi ke dalam
tujuh kelas seperti pada Tabel 2.2 berikut ini.
Tabd 2.2 Klasifikas Kemiringan Lereng

No Klasfikas (%) Kondisi

1 0-3 Datar

2 3-8 Landai

3 8-15 Bergelombang
4 15-30 Miring berbukit
5 30-45 Agak curam
6 45-65 Curam

7 > 65 Sangat curam

Sumber: (Rahim, 2000: 73)

2.5.4 Faktor Vegetas Pengelolaan Tanaman (C) dan Tindakan Konservasi
Tanah (P)

Faktor C menunjukkan pengaruh keseluruhan dari vegetasi, kondisi
permukaan tanah, dan pengelolaan lahan terhadap besarnya tanah yang hilang
(erosl). Faktor pengelolaan tanaman menggambarkan perbandingan antara
besarnya erosi lahan yang ditanami dengan tanaman tertentu dengan pengelolaan
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terhadap besarnya eros tanah yang tidak ditanami dan diolah bersh dalam
keadaan identik (Suripin, 2004). Faktor P adalah perbandingan antara tanah
tereros rata-rata dari lahan yang mendapat perlakuan konservasi tertentu terhadap
tanah tereros rata-rata dari lahan yang diolah tanpa tindakan konservasi, dengan
catatan faktor-faktor penyebab erosi yang lain diasumsikan tidak berubah (Asdak,
2002:81). Tabel 2.3 disgjikan nilai faktor CP di DAS Brantas.

Tabd 2.3 Klasifikas Bahaya Erosi

Jenis Tataguna L ahan Nila CP
Pemukiman 1
Rawa/Hutan Rawa 0,01
Empang 0,001
Pabrik/Bangunan 1
Bandar Udara/Pelabuhan 1
Penggaraman 1
Sungai 0,001
Pasir 1
Danau/Bendungan 0,001
Tanah kosong/Padang rumput 0,02
Semak belukar 0,1
Sawah irigas 0,02
Sawah tadah hujan 0,05
Hutan 0,001
Kebun 0,3
Ladang 0,28

(Sumber: Bappenas, 2012:20)

26  KeasTingkat Bahaya Erosi

Dalam Kemenhut (2009), tingkat bahaya eros diklasifikasikan ke dalam
lima kelas. Klasifikasi tersebut akan memberikan gambaran tingkatan eros yang
terjadi sehingga dapat dijadikan pedoman dalam perencanaan pengelolaan tanah
selanjutnya. Batas maksimum lgju erosi yang dapat diterima untuk berbagai
macam kondis tanah seperti terlihat pada Tabel 2.4.
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Tabd 2.4 Klasifikas Bahaya Erosi

K elas Bahaya Er osi Laju Eros K eterangan
(ton/ha/tahun)
I <15 sangat ringan
[ 15-60 Ringan
Il 60 - 180 Sedang
AV 180 - 480 Berat
V >480 sangat berat

Sumber: (Kemenhut, 2009:52)

27 ArcGIS

ArcGIS adalah salah satu software yang dikembangkan oleh Environment
Sience & Research Institute (ESRI) yang merupakan kompilasi fungsi-fungsi
dari berbagai macam sofware GIS. Software ini mulai dirilis oleh ESRI pada
tahun 2000. ArcGIS merupakan salah satu software yang dapat digunakan untuk
melakukan analisis spasial. ArcGIS lebih sering digunakan karena memiliki alat
atau tools yang komprehensif untuk melakukan analisa data dalam bentuk raster
(ESRI, 2006: 2).
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BAB 3. METODOLOGI PENELITIAN

3.1  Tempat dan Waktu Penelitian

Penelitian ini dilaksanakan di Laboratorium Teknik Pengendalian dan
Konservasi Lingkungan, Jurusan Teknik Pertanian, Fakultas Teknologi Pertanian,
Universitas Jember dan UPT PSDA Kediri yang meliputi kabupaten Kediri,
Nganjuk dan Jombang mulai bulan Juni 2015 sampai November 2015.

Wilayah administratif UPT PSDA Kediri Proving Jawa Timur. Luas
wilayah sebesar 399.963,1 ha pada proyeksi peta UTM 49 Southern Hemisphere
1984 dengan datum global WGS84. Berikut Gambar peta lokasi penilitian di
wilayah UPT PSDA Kediri disgikan pada Gambar 3.1 berikut.

PETA ADMINISTRASI UPT PSDA KEDIRI
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Gambar 3.1 Lokas Penelitian UPT PSDA Kediri
(Sumber: Hasil Analisis ArcGIS dan Ms. Excel 2007, 2015)
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3.2 Alat dan Bahan Pendlitian
3.21 Ala

a

Alat yang digunakan dalam penelitian ini antaralain sebagai berikut:
Seperangkat persona computer (PC)
Fungs dari komputer sebagai media kerja untuk memasukkan, mengolah, dan
menampilkan data hasil penelitan;
Software ArcGIS
Fungs dari software ini sebagai platform operasional, penyusunan, dan editing
layer;
Microsoft Excel 2007

Fungs program ini untuk memasukkan dan memperbaiki data sebelum diolah;

3.2.2 Bahan

Bahan yang digunakan dalam penelitian ini berupa data sekunder antara

lain sebagai berikut:

a

Peta sebaran stasiun hujan untuk menentukan faktor R;

b. Petajenis tanah untuk menentukan faktor K;

c. Petatata gunalahan sebagai penyedia data objek untuk faktor (CP);
d.

e. Datacurah hujan harian (times series) 5 tahun 2004 - 2008;

Data DEM dengan resolusi 30 x 30 m data objek untuk faktor (LS);
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3.3  Prosedur Pendlitian
Prosedur pendlitian ini diGambarkan pada diagram alir penelitian Gambar

3.2 berikut:
< Mulai >

Inventarisasi Data

v

Pengolahan data curah hujan menggunakan Microsofi Excel

Input layer GIS (data objek) dan data atribut
1. Peta sebaran stasiun hujan
2. Peta jenis tanah
3. Data DEM dengan resolusi 30 x 30 m
4. Peta tataguna lahan

A
Pengolahan layer GIS menggunakan

software AreG1S yang menghasilkan:
1. Faktor R

2. Faktor K

3. Faktor LS

4. Faktor CP

4

Penggabungan layer GIS menggunakan
persamaan A - R x K x LS x CP

|

Klasifikasi

v

Layout Peta Tingkat Bahaya Erosi

C Selesai >

Gambar 3.2 Diagram Alir Prosedur Pelaksanaan
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3.3.1 Inventarisasi Data

Data yang digunakan pada penelitian ini terdiri dari data rentang waktu
(time series) dan data spasial. Data rentang waktu terdiri dari data curah hujan
harian. Data spasial terdiri dari data atribut dan data obyek. Data atribut terdiri
dari data erodibilitas tanah, data tata guna lahan dan data erosivitas hujan yang di
dapat dari hasil perhitungan, sedangkan data obyek terdiri dari peta jenis tanah,
peta sebaran stasiun hujan, dan data DEM dengan resolus 30 x 30 m. Data
tersebut diperolen dari Laboratorium Teknik Pengendalian dan Konservasi
Lingkungan, Jurusan Teknik Pertanian, Fakultas Teknologi Pertanian, Universitas

Jember.

3.3.2 Pengolahan Data Curah Hujan

Pengolahan data curah hujan yaitu pengolahan data curah hujan harian
menjadi data hujan bulanan. Kemudian dicari data rata-rata curah hujan tahunan
dalam satuan mm/tahun. Pengolahan data curah hujan bertujuan menghitung nilai
erosivitas sesua persamaan 2.2. Data hujan yang dipakal yaitu antara tahun 2004
— 2008. Metode yang digunakan untuk mengolah data curah hujan harian menjadi
rata-rata hujan tahunan yaitu metode aljabar dengan memanfaatkan program Ms.
Excel 2007. Data dari setigp stasiun hujan dianalisis untuk diperoleh nilai

erosivitias (R).

3.3.3 Input Layer GIS (Data Obyek) dan Data Atribut

Input layer-layer GIS (data obyek) yang sudah ada yaitu layer sebaran
stasiun hujan, layer jenis tanah, data DEM dan layer tataguna lahan. Peta sebaran
stasiun hujan untuk menentukan faktor erosivitas. Peta jenis tanah untuk
menentukan faktor erodibilitas. Data DEM dengan resolusi 30 x 30 m data objek
untuk faktor. Semua layer yang diinput masih dalam format vektor kecuali layer
DEM vyang telah dalam format raster. Data curah hujan yang telah diolah,
kemudian diinput sebagai data atribut untuk masing-masing stasiun hujan dengan
cara menambahkan field baru pada Open Atribut Table. Data erodibilitas tanah
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diperoleh dari peta jenis tanah. Data tataguna lahan diinput pula sebaga data

atribut layer tataguna lahan dengan cara yang sama.

3.34 Pengolahan Layer GIS

Nilal erosivitas (R) dapat dihitung menggunakan persamaan (2.2) pada
Microsoft Excel 2007. Nila tersebut diinput ke dalam layer stasiun hujan.
Penyebaran atau distribusi erosivitas hujan ditentukan menggunakan interpolasi
Inverse Distance Weighting (IDW). IDW merupakan model yang relatif paling
sederhana dibandingkan dengan 2 Model lainnya. Model ini mengasumsikan
bahwa titik yang nilainya diduga akan dipengaruhi nilainya oleh titik lain yang
berdekatan secara spasia (Trisasongko et al., 2008). Ouput hasil interpolasi
berupa layer faktor R berformat raster. Kemudian layer tersebut diclip
menggunakan peta region UPT PSDA Kediri. Format layer jenis tanah diubah
yang semula dalam format vektor menjadi format raster menggunakan menu
Rasterize (Vektor to raster) untuk menghasilkan layer faktor erodibilitas. Vektor
adalah serangkaian instruksi matematis yang dijabarkan dalam bentuk, garis, dan
bagian-bagain lain yang saling berhubungan dalam sebuah Gambar. Raster
merupakan cell yang mengandalkan jumlah pixel dalam satu satuan tertentu.
Semakin rapat pixel maka semakin baik kualitas Gambar.

Layer tataguna lahan dikonversi menjadi format raster untuk menghasilkan
layer faktor pengelolaan tanaman dan faktor konservas tanah (CP). Untuk
merubah format tersebut dengan menggunakan menu Toolbox Conversion
Tools>Polygon to Raster.

3.3.5 Penggabungan Layer GIS

Semua layer faktor penyebab eros ditampilkan dalam bentuk raster.
Penentuan besarnya prediks eros setigp satuan lahan dilakukan dengan
mengalikan dari setiap faktor penyebab erosivitas hujan (R), erodibilitas tanah
(K), panjang dan kemiringan lereng (LS), dan penggunaan lahan (CP) dengan
menggunakan raster calculator sesuai dengan persamaan 2.1 yaitu perkalian dari
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tigp faktor penyebab erosi dilakukan setelah super posisi (overlay) dari peta
penyebab erosi. Sehingga dihasilkan berupa layer petalgju erosi.

3.3.6 Klasifikas

Nila prediks eros yang sudah dihasilkan kemudian diklasifikasikan
sesuai dengan tingkat bahaya erosi sangat ringan, ringan, erosi sedang, erosi berat
dan erosi sangat berat sesuai Tabel 2.3.

3.3.7 Pembuatan Layout Peta Tingkat Bahaya Erosi

Pembuatan layout peta tingkat bahaya erosi ini dibuat setelah proses
klasifikas telah selesai dan mengahasilkan kelas — kelas bahaya erosi. Dari hasil
penggabungan layer GIS, peta ditampilkan dalam bentuk layout seperti yang
disgikan pada Gambar 3.1. Penambahan legenda, skala, grid, mata angin, dan
judul merupakan standart kelengkapan peta. Setelah penambahan elemen-elemen
peta ditambahkan, peta dissmpan, kemudian diekspor melalui Toolbar File >
Export untuk menghasilkan peta berformat .jpg dengan resolusi 450.

34  Perhitungan Besar Eros
34.1 Faktor R

Nila erosivitas hujan dapat dihitung berdasarkan data hujan yang
diperoleh dari penakar hujan otomatik dan dari penakar hujan biasa. Di Indonesia
Bols menentukan persamaan untuk menghitung nilai R berdasarkan pada studi
empiris dari rata-rata tahunan curah hujan (P) dalam satuan mm (Teh et al., 2011).
Besarnya erosivitas hujan dapat dihitung menggunakan persamaan berikut

_ 2,5P%
=" 100(0'0?3P+0'?3||---|-||||||||-|||||||-|-|||||||-|-|-|-|-|-|-|-|-------------- DRI}

ereren(30)

Keterangan: R = Indeks erosivitas rata-rata per bulan (MJ.mm/tahun)
P = Curah hujan rata-rata tahunan (mm/tahun)
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3.4.2 Faktor K

Erodibilitas tanah dapat ditentukan berdasarkan klasifikasi nilai pada Tabel
2.1 dan disesuaikan dengan jenis tanah tempat penelitian. Data yang telah
didapatkan di input ke dalam peta jenis tanah dengan menggunakan software
ArcGIS dengan menggunakan menu Toolbox Conversion Tools>Polygon to
Raster yang kemudian dikonversi dalam format raster.

3.4.3 Faktor LS

Nilai L dan S dapat dicari berdasarkan persamaan 2.3. Akumulasi airan
(X) merupakan nilai pixel yang dipengaruhi oleh aliran dari pixel di lereng atas.
Data DEM diolah menjadi slope dalam bentuk dergjat menggunakan menu Spatial
Analyst Tools > Surface > 9Hope. Kemudian untuk menentukan flow
accumulation atau jumlah airan tigp cell menggunakan menu Spatial Analyst
Tools > Hydrology > Flowaccumulation dan dilakukan perhitungan nilai LS
menggunakan Raster Calculator. Penulisan rumus di dalam Raster Calculator
seperti berikut ini.

LS=Power ("facc"*30/22.13,0.5)* Power (Sn("slope")/0.0896,1.3)

3.4.4 Faktor CP

Layer tataguna lahan dikonversi menjadi format raster untuk menghasilkan
layer faktor pengelolaan tanaman dan faktor konservas tanah (CP). Untuk
merubah format tersebut dengan menggunakan menu Toolbox Conversion
Tools>Polygon to Raster.
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BAB 5. PENUTUP

51 Kesmpulan

. Total lgu eros wilayah administratif UPT PSDA Kediri yaitu 15,79
ton/haltahun atau 1,32 mm/tahun. Dengan demikian, lgju erosi masih di bawah
batas normal dari erosi yang ditoleransi.

. Tingkat bahaya eros diklasifikas kan menjadi 5 kelas yaitu sangat ringan
(1,68 ton/haltahun), ringan (32,46 ton/haltahun), sedang (101,72 ton/haltahun),
berat (282,33 ton/haltahun), dan sangat berat (1.297,58 ton/haltahun) pada UPT
PSDA Kediri.

. Tingkat bahaya erosi kelas ringan UPT PSDA Kediri seluas 319.043,61 ha atau
80,54% bagian, dan tingkat bahaya erosi kelas sangat berat seluas 870,32 ha
atau 0,22% bagian.

5.2 Saran
1. Pada pendlitian yang telah dilakukan, data DEM yang digunakan adalah 30 x

30 m. Ada baknya apabila penelitian selanjutnya resolus yang digunakan
lebih kecil agar perhitungan laju erosi lebih teliti.

. Perlu dilakukan pembaruan data seperti peta tataguna lahan dan data curah
hujan. Karena pertumbuhan terus bertambah sehingga dimungkinkan terjadi
penambahan lahan pemukiman, dan perubahan iklim sehingga mempengaruhi

intensitas hujan.
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